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A guide to a smooth transition to the Minute Menu CX program. This guide
includes links to help documents, e-Learning Courses, and training videos
that guide users through each task needed to take full advantage of the
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Welcome to Minute Menu CX

Dear Center,

We are so glad to have you on board as a part of the Minute Menu family! From here on out, you can
think of Minute Menu as a partner in achieving your goals for your agency--whether they are to improve
program integrity, to grow your program, or simply to make life easier by taking some of the hassle out of
processing claims every month.

This document provides clickable hyperlinks (blue and underlined) that will take you directly to training
documents, blog posts, e-Learning courses, and training videos (please be patient as the links may take a
few seconds to open). These resources will guide you through each task needed to make a smooth
transition to Minute Menu CX, and help you take advantage of all areas of the program.

Some steps listed in this guide may not be applicable to your agency and can be skipped.

Please contact me, your Implementation Specialist, if you have any questions.

Thank you,

Dawn Perez

dawn@minutemenu.com

(972) 671-5211 x0206
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Installation and Login

Installation

To install Minute Menu CX for the first time, or to install on additional computers, go to
www.minutemenu.com/centerwelcome and use the login ID/password that have been \Z
provided to you. (

Click here to view a blog post about installing Minute Menu CX on multiple computers.

Verify Company Information

Go to Administration >> Manage Client Info and update company information as needed to ensure it
prints correctly on reports.

Start the Training Process

Go to training.minutemenu.com and access the Minute Menu CX training page. Familiarize yourself and
key staff members with the various training documents, training videos, and e-Learning courses available
on the website.

Take the “Getting Started on CX” e-Learning course and watch the “Center Monthly Process Overview”
training video for an overview of the program.
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http://www.minutemenu.com/centerwelcome
http://blog.minutemenu.com/2012/02/27/install-minute-menu-cx-on-multiple-computers/
http://training.minutemenu.com/Portals/0/Documents/pdf/cx/Getting_Started_Scanning.pdf
http://training.minutemenu.com/Portals/0/Documents/Articulate/cx/Getting_Started_on_CX_eLearning_Course/player.html
http://www.youtube.com/watch?v=GDnrLMQIETA&feature=player_embedded

Verify and Add Center Data

Manage Center Information

Go to File >> Manage Center Information and fill out
information on all 3 tabs: General, License/Schedule, and
Oversight.

" Bl Children b List Chiildren ] Activate Children [)Claims Y staff B Calendar [ Alerts

License [ Schedule [ COversight

.

g

E!!!IIIII |

cindyvian@gmail.com

AT-RISK CENTERS

Read help documentation: Go to Help >> Help Index, Managing At-Risk Centers.

Watch the "Managing At-Risk Licenses and Children” training video to learn how to assign at-risk licenses
to centers and mark children as eligible for the at-risk program.
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https://service.minutemenu.com/Centers/StaticResources/Help/AtRiskCenters.pdf
http://youtu.be/Hi8IlWSak08

Advance Claim Month

Make sure that the claim month listed at the top of the screen is on the current calendar month.

File = Scanning = Claims » Menus / Attendance = Reports = Tools » Admunistration = Help -

ﬁEnraII Child nRecard Attendance @F‘.ecurd Menus EMEHU Calendar ﬂChiIdren L-jCIaims

If the month listed is not correct, change it by going to Claims >> Advance Claim Month. Then click
the + key to go forward (or — key to go back). Be sure to save before exiting the screen. The month

listed at the top of your screen will immediately update.

% Change Claim Month

& Minute Menu CX  v1.9.0.10274 Demo Center (2560:55621) Claim Month: May 2013 Claim Month
File = Scanning ~ | Claims +| Menus / Attendance + Reports ~ Tools = Administration + Help - D May 2013
B enroll child Process Claims enu Calendar [ Children [ Claims

Calculate Blended Claim Rates
Milk Audit

Manually Disallow Meals

List Claims

< ‘Advance Claim Month S |

[[] Mutomaticaly Withdraw Expired Enrollments

()

2

Manage Formula Types

Go to Tools >> Manage Formula Types and add formula brands/types
that are offered by centers. This will populate the “"Formula Offered by
Center” and “Parent’s Preferred Formula” dropdown boxes located on the
Child tab of the Manage Child Information screen.

To add a formula, click the Add button. Then click the cursor into the blue
highlighted area and start typing. Click the Save button, and then Add
another formula or Close the screen.

3 Manage Formula Types [E=R(ESH )
Neme
Warketplace Formua

Instructions

Click [Add]to add a new row. Click any existing row and type to
editt. Rememberto [Save] changes when done, Tothrow out
changes, just [Close] without saving

e eimis = lmm

Manage School Calendar
Use the School Calendar to mark school-out days. The calendar is Pyrm——s =
accessible from Menus/Attendance >> Manage School Calendar. T

Select a specific child or your center as a whole, and then double-click
on a calendar date to add the “school out” designation.

==

File ~ Scanning ~ Claims ~ | Menus / Attendance - | Reports ~ Tools » Administration - Help ~

ﬁEmoII Child uRE(D!d At Create Menu Template Children UC\aims
Manage Menu Templates
Menu Calendar

Record Center Menus

Suectaz Carder

Tiesay azandey Trursiey Pecy

eco 7 Meal Counts

[ Manage School Calendar > Pt clek 5 ackd = mrmcve m el ey
Dinabie-cRoi L0 80 OF (et & SN S0M00] Sl Ry
- clek
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Enrolling Children

Importing Children

A recurrent import from another program such as Procare 10 may be possible.
PROCARE

e If a Procare 10 import will be used, DO NOT enroll the children (the initial import is an integral part
of the process).
e The Centers Integration Service (CIS) requires some setup.
o View the Quick Start Guide for a summary of the process.
o Please view the CIS Startup Guide for detailed instructions on setting up CIS with Procare.
e For any questions or support regarding the import, please see the Procare Knowledge Base page
and/or contact their technical support department.

OTHER SOFTWARE

Importing children from other programs may be possible, but some setup may be required. Please
contact your Implementation Specialist to see if an import is possible.

Enroll Children

To enroll a child, click the Enroll Child button. Fill out information on all 3 tabs: Child, Parent, and
Oversight.

View the Enroll Child Training Video on training.minutemenu.com to learn how to enroll a child into Minute
Menu CX.

View the IEF Calculator Tool Training Video to learn how to set FRP statuses or enter income
information/categorical eligibility into the program for each child.

Centers should obtain parent-signed enrollment forms and IEF

(income eligibility forms). Children can have one of 3
statuses:

Children will appear as “pending” status when initially

enrolled. Children should be “activated” after the FRP rate has Active: Completed enrollment

been assigned and the parent signature on the enrollment

form has been verified. The software will provide a prompt to Pending: Incomplete enrollment

activate children if the IEF Calculator Tool is used, otherwise: ) .
Withdrawn: No longer in care

To activate children:

1. Click the Children shortcut button.

Click the Pending option directly to the right of the Select a child... dropdown box to filter
children by pending status.

Select a child from the dropdown box

4. Go to the Oversight tab.

w

6|Page

Last Updated: 01/28/2014


http://www.training.minutemenu.com/Portals/0/Documents/pdf/cx/CIS_Quickstart_Guide.pdf
http://www.training.minutemenu.com/Portals/0/Documents/pdf/cx/CIS_Startup_Guide.pdf
http://procaresupport.com/Resources/Knowledge-Base/Minute-Menu.aspx
http://youtu.be/jzimJMZnQyc
http://training.minutemenu.com/Portals/0/Documents/pdf/cx/Getting_Started_Scanning.pdf
http://youtu.be/T6A-TxWb83I

5. Click the Activate Child box.

Select a Child to View

[Martin, Travis - @AdivePermgWIfﬂ'awn anerl—;,

LastName  FirstName  DOB Age FRP Type  FRP Reason Status

Martin Travis 4% 4N Pending

After enrolling children, print the child roster report to review your work. To print the report go
to Reports>>Children>>Child Roster.

Center Dashboard

View the Center Dashboard training video to learn how to

use the dashboard to make sure that all required "

information is collected. This will help you maximize your - . e @wmﬁnﬂ
Child: Enrollments - Income

reimbursement. Also, view the Center Dashboard Help | 1 e

Document for a detailed explanation of how this tool works.

The help document is also accessible from Help >> Help
Index.

Minute Menu CX

File » Scanning = Claims ~ Menus / Attendance ~ Reports ~ Tools ~ Administration ~
' Enroll Child . Record Attendance E Record Menus Menu Calendar ' Children

Contact Minute Menu Technical Support
Getting Started Guide

Form Tips for Scanning

Release Motes

Minute Menu CX Subscription Status
View Error Log File

Check Dynamic Load files

About Minute Menu CX...

Help Index

7|Page
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http://www.youtube.com/watch?feature=player_embedded&v=rwJcMmo8QDc
https://service.minutemenu.com/Centers/StaticResources/Help/CenterDashboard.pdf
https://service.minutemenu.com/Centers/StaticResources/Help/CenterDashboard.pdf

Foods and Menus

Customize Food List

View the Managing Foods and MPR Quantities document to learn how to manage foods and for an
introduction to the Menu Production Record.

Make sure that the foods available in Minute Menu CX are sufficient to begin planning and recording
menus. View the Managing Foods training video to learn how to add and remove foods on the food list.

To start managing foods go to Administration>>Manage Foods.

Create Menu Templates (Optional)

Make menu planning more efficient and create reusable menu templates! Watch the Creating Menu
Templates training video located on training.minutemenu.com to get started.

To create a menu template:

1. Open Minute Menu CX
2. Go to Menus/Attendance>>Manage Menu Templates
3. Choose the category to add a meal to: Breakfast, Lunch/Dinner, or Snack.
4. Click Add button to create a new template
5. Give the template a short but descriptive title
6. Record the food components for the meal by clicking the [...] button
7. Click Save
Tt R e m—
Lo Ft ot 159 | bt 05 oy
Tottila {027) Spinach (176) 1% Millc / over 2 years
Bran Chex (041) Strawberies {035} 1% Mk / over 2 years
Pie Crust (017) Broceoli - Vicamin A (5.. 1% Milk / over 2years ...
English Muffin (007) Peaches (025) 1% Milk / over 2 years
Qatmeal (114) Apples (001} 1% Milk / over 2 years
8|Page
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http://training.minutemenu.com/Portals/0/Documents/pdf/cx/Managing_Foods_and_MPR_Quantities.pdf
http://youtu.be/yxSygUai2RM
http://www.youtube.com/watch?v=0y8-iybeBeE&feature=player_embedded
http://www.youtube.com/watch?v=0y8-iybeBeE&feature=player_embedded
http://training.minutemenu.com/Portals/0/Documents/pdf/cx/Getting_Started_Scanning.pdf

To use the template you created, click the Record Menus Focord Mom -
shortcut button. wxt IEEICNEETERD = —
Non - Infant Foods e Eaies) Meal Counts S —
Bread / At m ::am::gmn T g
For any meal type that has a template available, you will T - e
see a Use Menu Template button on that screen. (The L] G 0 G
menu template button will not be visible for meals that do - T
not have templates available.) Ete o =
Breast Mik / Fomula [.] Nor ks
Infant Cereal [.]
am:;::/ Formula [.] m
Inf Cereal / Meat / A -
Ft /Veg m
[ I I I

Start Recording Menus

Get started planning and recording menus! Click here to view the Planning and Recording Menus help
document. You can use menu templates that you created in the previous step or select foods individually.
To get started, click the Record Menus button at the top left of the screen.

3 Minute Menu CX  v1.10.0.10866 Demao Center (2560:55621) Claim Month: April 2013

File = Scanning ~ Claims = Menus / Att =z feports ~ Teols = Administration = Help -
ﬂEnrDII Child nRecDrdAttenda 3 mRecord Menus CF Menu Calendar ﬂChiIdren L-jCIaims

Watch the Record Menus training video to learn how to record a menu. Menus can be recorded anytime,
so feel free to preplan menus or record them as you go.

After you've recorded a few meals, take a look at the Menu Calendar (accessible from the \
plate/fork icon on the dashboard). Any day with a meal recorded will display the
abbreviation for that meal (BALPDE). Double click any day to edit a meal on that date.

You can copy and paste meals from the Menu Calendar. Copy and paste a single day, a pcns
week, or even a month if you like!

7 Menu Calendar EI@

To copy and paste a day of meals: Select the
Menu Calendar

day to copy, right click, and select the copy

option. Then select a day to paste it to, right (<] June2013 [~ ]

C|iC|(, and select the paste option. Sunday Mondsy | Tuesday | Wednesday | Thursday |  Friday Saturday
26 27 3B 2 30 31 June 01

To copy and paste more than one day of 2 3 + I o s 7 8

meals: Select the first day you want to copy. g‘ _ m” _ ”” _ . . .

Then, hold down the SHIFT KEY on your pelete

keyboard while you select the last day of the 6 v 8 B ® - 2

range that you'd like to copy. Right click on the = = S — 5 = =

selected area and choose the copy option.

Select the first day in the range you’d like to B e : i ) . ’

paste to, right click, and choose the paste Double cick any dateto e a mesl o that date. To Copy meals ef-cick onhe
! ! first day you wish to copy. then hold down the Shift key and left-click the last day
- nt to Copy. Then nght-ciick and chaose "Copy”. To Paste the meals,
optlon- ?’:ﬁ:ﬁm:dagyynuwai;ntguda:'lm:nFadg,TmrigEltYd\d:anad;n:s:fS:ﬂe"
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http://training.minutemenu.com/Portals/0/Documents/pdf/cx/Planning_and_Recording_Menus.pdf
http://www.youtube.com/watch?v=XJ6AB0jWqxk&feature=player_embedded

Estimate Attendance

After menus have been recorded, watch the .
) L. ) ) v+ Estimate Attendance o || =) E
Estimate Attendance training video. The Estimate _
Attendance tool assists users in planning how Estimate Attendance
much food to purchase and prepare. After a meal Select Date: | Thursday . May 09,2013 [~
is planned, use the tool to make an educated HEiEEe
h hld “ b t 0-3Mo 4-7Mo 8-11Ma 1-2%r 3-5Yr 6-12%r Adults Total
guess on how many c ildren will be presen. on g 5 : 5 ra— 0 2
future days. Then, view the Menu Production RAIE 0 0 0 0 0 0 0
Record (MPR) to see how much food will be needed Lunch g g g g E E E E
. PM Snack

based on those estimates. Drrer |0 0 0 0 0 0 0 0

. BV Snack |0 0 0 0 0 0 0 0
To estimate attendance, go to

- Aute Caleul
Menus/Attendance>>Estimate Attendance. o Ceiouse
Estimate Attendance From Last Thursday

Or use the shortcut button from the Record 5 Essmate From Most Fecers. Aserdance
Menus screen.
Type your own estimates in the grid at the top or
use the auto calculate feature at the bottom. _PrintMenu Production Record__| save J_close

Menu Production Record

Once menus have been recorded and attendance has been estimated, view the Menu Production Record.
A shortcut button is provided on the Estimate Attendance screen AND the Record Menu screen. The
report can also be accessed by going to Reports >> Menus >> Menu Production Record.

The Menu Production Record will display the foods, the quantity of food needed for each age group, and
the total amount of food needed based on the estimates you provided.

III

The final “actual” food totals will not be displayed on the report until the actual attendance/meal counts
have been taken for that meal.

Demo Center 1 Mon Infant Menu Production Record Demo Center
4155141415 Thursday 05/09/2013 4155141415
1.2 Yra 3-5Yrs B-12 'rs Adults Total Total Including Infants
Breakfast Estimated Attendance 5 10 5 o 20 26
Actual Attendance
Fod Serving Size By Age Qty Needed Per Gty Needed Per
Component Food Served/Planned 1-2 3-8 f-12  Adult EstAttendance  Actual Atendance Comments
Brd/Alt Waffles 112 sery 112 serv(1 serv |2 serv (12 1/2 zerv
Veg/Frt'Juice Bananas e |12c [12c |12c |B3Mc
Milke Fluid Milk 12¢ |34c 1¢ 1¢ 15 :f \
Quantity Needed Per Estimated Attendance Quantity Needed Per Actual Attendance
The program will determine how much food is This column will get filled in by the program
needed for all age groups based on Estimated automatically after the actual meal counts
Attendance. been entered for that meal.
10| Page
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http://www.youtube.com/watch?v=fQA5qs5ZuXY&feature=player_embedded

Recording Attendance/Meal Counts

There are 3 ways to record attendance and meal counts in Minute Menu CX:

1. Manually (Record Menus screen)

2. cx2go (mobile app)

3. Scanning

Manually

Teachers should be trained to record attendance on the Meal Count and Attendance forms. Print this form
by going to Reports >> Attendance >> Weekly Attendance + Meal Count Report. Watch the
Recording Meal Counts and Attendance on Paper training video. Use the Properly Marking Attendance and

Meal Count forms document to train Staff to fill out forms correctly.

Then watch the Recording Meal Counts and Attendance into Minute Menu CX training

Minute X

File » Scanning - Claims - Menus/ Attendance - |Reports -| Tools » Admini
Bl Enroll Child [§ Record Attendance [[5] Record Me

Attendance  »

Children
Checkbook

Daily Amtendance T TTes Coun

Menus

3
3
3
3

Receipts Monthly Claimed Meal Count Su

Monthly Paid Attendance Only R

Estimated Meal Count Summary

In/Out Times Daily Report
In/Out Times Weekly Report
Weekly Attendance + Meal Coun

R Weekly Attendance + Meal Count Report_) |

Blank Attendance + Meal Count Werkshect
Menthly Cleimed Attendance Only Report

Monthly Clsimed Meal Counts by Age Group
Menthly Cleimed Meal Counts by Child

Monthly Paid Mesl Counts by Age Group
Menthly Paid Meal Counts by Child

Weekly Paid Attendance + Meal Counts

Actual vs Estimate Meal Count Summary

eport

mmary

eport

it - One Class

video. Click the Attendance icon on the dashboard to open the function. Make sure that
the correct day is selected, and then filter by classroom to make data entry easier.

@ Record Attendance: Dawn's Little Tigers 051 == =]
Thusday . dancary 312013 O~ | Time Stated: 429PM
A =
Cnid Age  Pend Sck  SchOut At B A L 3 D £ In out n out B
Ty 6m ] =
Avios, Mertey 7 5m ] = 1
Avlos, Sky 2 m o 3l
Christopherson, John B m I o
Cruzes, Penelope P 2y 6m O =
Cruzes, Pricila B 6m o =
Depp, Johnny 10y &n [ l _
Grace, Erit 4 Om [ al
Greene, Rachel Ty Om 7] | 7] M ] ] ] ] -
—
L L o C L u Apply Times From
0 Enroliment
]
]
]
]
]
Print Attendance Detail Print In/Qut Times Save Close

Attendance

III

Use the “select all” check
boxes at the bottom for

—
quicker entry.

N|Page
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http://www.youtube.com/watch?v=kPavqXxhU0k&feature=player_embedded
http://www.minutemenu.com/NoAuth/CX/CXHelp/FillingOutFormsProperly.pdf
http://www.minutemenu.com/NoAuth/CX/CXHelp/FillingOutFormsProperly.pdf
http://www.youtube.com/watch?v=q0SgJNxmWRY&feature=player_embedded

cx2g0 Mobile App

The cx2go mobile app can be used to record attendance and meal counts and child
in/out times on a daily basis. Please see the cx2go website for more information.

The full version of the program is still needed for tasks such as: enrolling children, 2
managing classrooms, recording menus, printing reports, etc. go

The app can be accessed from various smart phones, tablets, and laptops. To access the app from a
laptop, go to cx2go.mobi using either the Chrome or Safari web browser (it will not work using Internet
Explorer.)

Two training videos on cx2go are currently available. Watch the cx2go - Recording Meal Counts and
Attendance training video to learn how to record daily meal counts and attendance. Watch the cx2go -
Recording In/Out Times video to learn how to record daily child in/out times in the app.

Attended
Serving 1
Sick
School Out

Scanning

The Weekly Attendance + Meal Count forms can be scanned into Minute Menu CX. Scanning will eliminate
the need to record attendance/meal counts (in the Record Attendance screen).

SETUP

Read the Getting Started Scanning help document.

Scanner(s) must be setup to meet specific scanning requirements. Please watch the Scanner Settings
training video to learn how to set up the scanner to meet these requirements.

TRAINING

Specific guidelines must be followed when printing and filling Hint: Con§ider pljoviding _
out the forms. Use the Properly Marking Attendance and Meal teachers with laminated copies
Count forms document to train Staff to fill out forms correctly. of the “Properly Marking

Attendance and Meal Count
Forms,” and keep one in every
classroom.

Use the Meal Counts and Attendance with Scanning e-Learning
course on training.minutemenu.com to train centers.

Read scanning blog(s) located on blog.minutemenu.com.
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http://www.minutemenu.com/web/cx.html#cx=cx2go
cx2go.mobi
http://www.youtube.com/watch?v=EIN98tc6Ez4&feature=player_embedded
http://www.youtube.com/watch?v=EIN98tc6Ez4&feature=player_embedded
http://www.youtube.com/watch?v=EgmsBABavaM&feature=player_embedded
http://www.youtube.com/watch?v=EgmsBABavaM&feature=player_embedded
http://training.minutemenu.com/Portals/0/Documents/pdf/cx/Getting_Started_Scanning.pdf
http://youtu.be/Kquy_jqA6ug
http://www.minutemenu.com/NoAuth/CX/CXHelp/FillingOutFormsProperly.pdf
http://www.minutemenu.com/NoAuth/CX/CXHelp/FillingOutFormsProperly.pdf
http://training.minutemenu.com/Portals/0/Documents/Articulate/cx/CX_Meal_Cts_Attn_w_Scanning/player.html
http://training.minutemenu.com/Portals/0/Documents/pdf/cx/Getting_Started_Scanning.pdf
http://blog.minutemenu.com/2012/02/20/managing-reviews/

Receipts

Enter Receipts (Optional)

RECEIPT
ITEM | $20

To enter receipts into Minute Menu CX, click the Receipts icon on the dashboard. The oo
amount of money spent on the food service (food, supplies, etc.) should be greater than e
or equal to the amount of money received for reimbursement by the CACFP. Entering

Receipts
receipts will allow centers to track expenses and run reports on those

expenses. Best Practice: Run the

“Non-Profit Status
Report” after receipts are
entered to make sure

Watch the Entering Receipts training video located on
training.minutemenu.com to learn how to add, edit, and/or delete

receipts. ) .
your Center is running a

To enter vendors for food/supplies, go to Tools >> Manage Vendors. non-profit food service.

Watch the Manage Vendors training video for more information on adding

vendors.

Policy Settings

Manage Policies

The Manage Policies function in Minute Menu CX controls many aspects of the program including edit
checks, user preferences, and much more. Review the policies to ensure that the program has been set up
to meet the standards and expectations of your agency.

Please view the Managing Policies document on training.minutemenu.com. To view a printout of the
policies, go to Administration >> Manage Policies, and click the Export option.

Policies should only be changed by the main decision makers of the company and/or those with the
authority to do so.

[ESE Eon &)

Policy Value [statecode [ |

Click the plus signs to

expand a category. \

Export the data to

Excel for a format
/ that’s printer friendly.

Use this function to corfigure the rules used by Minute Menuthat govem certain claims processing behavior and other features in theAfiute Menu system
WARNING: ing preferences mpropery can cause Minute Menu to mafunction - which may resut in the loss

erts. Ed jth extreme caution. I you have any questions about the impact of a preference ha
support before making the change:

e,
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http://www.youtube.com/watch?feature=player_embedded&v=q7zX7LKhVfA
http://training.minutemenu.com/Portals/0/Documents/pdf/cx/Getting_Started_Scanning.pdf
http://www.youtube.com/watch?v=O55JGgXm_W4&feature=player_embedded
http://training.minutemenu.com/Portals/0/Documents/pdf/cx/Managing_Policies.pdf
http://training.minutemenu.com/Portals/0/Documents/pdf/cx/Getting_Started_Scanning.pdf

End of Month Tasks

Process Minute Menu CX Claims

At the end of each month, all of the data will need to be “processed” by the software. This is how Minute
Menu CX will check the data in your system to ensure that all CACFP requirements have been met. But
DON’'T WORRY! This information is NOT final until you say it is! After the claim is processed, changes
can be made! Watch the Processing Claims training video to learn more about claims processing.

To process claims:

1. Go to Claims>>Process Claims.
Make sure that the “Calculate Blended Rates While Processing” box is checked (if this is not visible
in your account, skip that step.)

3. Make sure that the “Print OER"” box is also checked (the OER or Office Error Report will “print” to
screen, not to the printer. This option will simply open the report for you to view it after

processing).
4. Print or save the Minute Menu CX Claim Errors help document accessible from the bottom left

corner of the process claims screen (needed for reviewing the OER).
5. Click the Process button

o Process Claims EI@
Process Claims
clam flere: o Process New Cams Make sure the Print
/| Calculate Blended Rates While Processing Reprocess Bdsting Claims / OER bOX iS Checked |
/| Print OER K
License =4 Center Name Locked
Center D51 Dawn's Little Tigers
Print or save this Total Claims: 1
HELP document! \
= Process Close

Next you’ll need to use the Claim Error Help document to review each of the claim errors on the OER.
Each claim error has a reference number. Use the reference number to look up the error in the help
document. Each and every error should be researched.
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http://youtu.be/x081ZsoVMBc
http://www.minutemenu.com/NoAuth/CX/CXHelp/MMCXClaimErrors.pdf

Any errors that were received due to incorrect or incomplete data can be eliminated by fixing the data and

reprocessing the claim.
To reprocess the claim:

1. Go to Claims>>Process
Claims.

2. Select the “"Reprocess Existing
Claims” option.

3. Place a check in the box next to

the claim.
4. Click the Process button.

. Process Claims

Process Claims

Claim Month: | April 2013

h |

| Calculate Blended Rates While Processing

=R ECR =)

< @ Reprocess Bxsting Claims >

| Print OER

Some errors that you receive may be valid and indicate that a meal or a child should not be claimed.
Centers should only accept reimbursement for meals and children that meet CACFP food program

requirements.

Take the Sponsor Monthly Process four-part training course located on training.minutemenu.com to learn
about each step of the monthly process including: managing data, processing claims, reviewing claims,

and other monthly tasks.

Submit Claims to State

After the claim has been processed and all errors have been reviewed (and fixed as needed) the claim is
ready to be submitted to the state. Use the reports in Minute Menu CX to get the data to submit to your

state.

It is important to note that Minute Menu CX is not directly connected to your state in any way.

To begin the process, go to Claims >> Submit Claims to State.

Use these reports to
get the data to enter

your claim into the \
state website.

% Submit Claim To State

o5 ]

Submit Claim to State

Claim Morth: | Apri 2013

h |

Submizsion Batch: |NI Submissions hd |
Reports
Certer Claim Totals - Print D
(Center Claim Totals
Participant Totals by Center
State Summarny
Summary by FRP
Marthly Receipt Totals

MNon Profit Status Report

Mark as
Submitted | Help | | Close |

Select a report from the Reports dropdown box and then click Print. Most agencies run the State
Summary report, and use that information to enter the claim into the state website.
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http://training.minutemenu.com/Portals/0/Documents/Articulate/cx/CX_Sponsor_Monthly_Process_Part_1w_Scanning/player.html
http://training.minutemenu.com/Portals/0/Documents/pdf/cx/Getting_Started_Scanning.pdf

Some states may have an export/upload file available which allows you to upload a file to your state
website rather than having to manually type the numbers in. If your state has an upload file, you will see
the “State Claim File” in the Export Files dropdown box. If an upload file is not available for the state,
the field will most likely be greyed out. Click the Generate button to create the file, save it to your
computer (in a location that you can easily find again), and then go to your state website, and upload that

file.

If an upload file is
available in your state,

vou'll see it here. \
q

'+ Submit Claim To State

Submit Claim to State

Caorporation: |

Claim Morth: | Apri 2013

Submission Batch: |AII Submissions

Reports
|Cerrter Claim Totals - | Print
Export Files

=N ER(=>™)

[ State Claim File

v| | Generate )

Mark as
Submitted | Help | | Close

A4

Please review the Submitting Claims to the State help document for more information.

After the claim is submitted to the state, go to Claims >> Submit Claims to State and click Mark as
Submitted. This effectively locks that claim information down, so if it is ever changed after it has been
marked as submitted, those changes are tracked separately from the original claim(s).

If you have any questions, you can go to Help >> Contact Minute Menu Technical Support for

assistance.
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http://www.minutemenu.com/NoAuth/CX/CXHelp/SubmittingToState.pdf

Resources

Minute Menu Corporate Website WWW.minutemenu.com
Minute Menu Training Website training.minutemenu.com
Minute Menu Blog Website blog.minutemenu.com
Minute Menu Technical Support Email Address cxhelp@minutemenu.com
Minute Menu Main Phone (972) 671-5211
Minute Menu Fax (972) 235-8651
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